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• Date: December 12, 2011 
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Copyrights and Trademarks 

© 2011 Utah Scientific, Inc., All rights reserved. Any use or reproduction of this guide’s 

contents without the prior written consent of Utah Scientific, Inc. is strictly prohibited. 

• SoftPanel 2 (SP2) is a trademark of Utah Scientific, Inc. 

• Windows is a registered trademark of Microsoft Corporation. 

• All other product names and any registered or unregistered trademarks mentioned in this 
guide are used for identification purposes only and remain the exclusive property of their 
respective owners. 

 
 

 

Notice 

Information contained in this guide is subject to change without notice or obligation. While 

every effort has been made to ensure that the information is accurate as of the publication 

date, Utah Scientific, Inc. assumes no liability for errors or omissions. In addition, Utah Scien- 

tific, Inc. assumes no responsibility for damages resulting from the use of this guide. 
 
 
 

FCC Compliance (USA) and Digital Equipment Compliance 
(Canada) 

This equipment has been tested and found to comply with the limits for a Class A, digital 
device, pursuant to Part 15, Subpart B of the FCC Rules and the Canadian EMC Requirement 

(ICES-003). These limits are designed to provide reasonable protection against harmful 
interference when the equipment is operated in a commercial environment. This equipment 

generates, uses, and can radiate radio frequency energy and, if not installed and used in 

accordance with the instruction manual, may cause harmful interference to radio 
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communications. Operation of this equipment in a residential area is likely to cause harmful 

interference, in which case, the user will be required to correct the interference at their own 
expense. Shielded cables must be used to ensure compliance with the FCC Class A limits. 

 
 

 

Declaration of Conformity 

Utah Scientific, Inc. 

4750 Wiley Post Way, Suite 150 

Salt Lake City, Utah 84116-2878 U.S.A. 

We declare our sole responsibility that the SqueezeMAX HD system is in conformance with 

the following standards: 

• EN50081-1 Generic Emission Standard 

• EN50082-1 Generic Immunity Standard 

• IEC-950 Product Safety 

• C-UL 1950 Product Safety 

• UL 1950 Product Safety 

Following the provisions of the Directive(s) of the Council of the European Union: 

• EMC Directive 89/336/EED 

• Low Voltage Electrical Directive 72/23/EEC 

Utah Scientific, Inc. hereby declares that the product specified above conforms to the above 
Directive(s) and Standard(s). 

 

 
 
 

 

Product Reclamation and Recycling Program 

Utah Scientific Inc. is committed to environmentally responsible behavior. As part of this com- 

mitment, we work to comply with environmental standards such as the Waste Electrical and 
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Electronic Equipment (WEEE). This directive regulates electronic waste management and the 

reduction or elimination of specific hazardous materials in electronic products. The WEEE 

Directive requires electrical and electronics manufacturers to provide mechanisms for the 
recycling and reuse of their products. 

In accordance with Article 11 (2) of Directive 2002/96/EC (WEEE), UTSCI is in compliance 
with all products put on the market after January 1. Utah Scientific Inc. provides recycling sup- 

port for out equipment worldwide to comply with the WEEE Directive. 

Products returned through our reclamation process are recycled, recovered, or disposed of in 
a responsible manner. Our packaging is designed to be recycled and should be handled in 

accordance with your local recycling policies. 
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Company Information 

 

Utah Scientific, Incorporated 

4750 Wiley Post Way, Suite 150 

Salt Lake City, Utah 84116-2878 U.S.A. 

• Telephone: +1 (801) 575-8801 

• FAX: +1 (801) 537-3098 

• Technical Services (voice): +1 (800) 447-7204 

• Technical Services (FAX):   +1 (801) 537-3069 

• E-Mail -General Information: info@utsci.com 

• E-Mail -Technical Services: service@utsci.com 

• World Wide Web: http://www.utahscientific.com 

• After Hours Emergency: +1 (800) 447-7204. Follow the menu instructions for Emergency 
Service. 

mailto:info@utsci.com
mailto:service@utsci.com
http://www.utahscientific.com/
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Warranty Policies 

Hardware Warranty 

Utah Scientific, Inc. warrants to the original purchaser that the Utah Scientific hardware is free 

from defects in materials and workmanship and will perform substantially in accordance with 

the accompanying written materials under normal use and service for a period of ten (10) years 

from the date of shipment. Any implied warranties on hardware are limited to ten (10) years. 

Some states/jurisdictions do not allow limitations on duration of an implied warranty, so the 

above limitation may not apply to certain specific purchasers. 

Software Warranty 

Utah Scientific warrants that the software will perform substantially in accordance with the 

accompanying written materials for a period of one (1) year from the date of shipment. 

Customer Remedies 

For the first one (1) year after purchase of the software and the first ten (10) years after the date 

of purchase of the hardware, Utah Scientific’s and its suppliers’ entire liability and purchaser’s 

exclusive remedy shall be, at Utah Scientific’s option, either: 

• Return of the price paid, or 

• Repair or replacement of the software or hardware that does not meet the above warranties 

and is returned to Utah Scientific under the returned materials authorization (RMA) 

process with freight and forwarding charges paid. 

After the initial warranty periods, purchaser’s exclusive remedy is the repair or replacement of 

the hardware upon payment of a fixed fee to cover handling and service costs based on Utah 

Scientific’s then-current price schedule. The above warranties are void if failure of the 

software or hardware has resulted from an accident, abuse, or misapplication. Any replacement 

software or hardware will be warranted for the remainder of the original warranty period or 

thirty (30) days, whichever is longer. 
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No other warranties. To the maximum extent permitted by applicable law, Utah Scientific and 

its suppliers disclaim all other warranties, either express or implied, including, but not limited 

to implied warranties of merchantability and fitness for a particular purpose, with regard to the 

software, the accompanying written materials, and any accompanying hardware. This limited 

warranty gives the purchaser specific legal rights. These rights may vary in certain states/ 

jurisdictions. 

No liability for consequential damages. To the maximum extent permitted by applicable law, 

in no event shall Utah Scientific or its suppliers be liable for any damages whatsoever 

(including without limitation, damages for loss of business profits, business interruption, loss 

of business information, or any other pecuniary loss) arising out of the use of or inability to use 

Utah Scientific products, even if Utah Scientific has been advised of the possibility of such 

damages. Because some states/jurisdictions do not allow the exclusion or limitation of liability 

for consequential or incidental damages, the above limitation may not apply in those 

circumstances. 
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Introduction 

1 
SoftPanel 2 Overview 

Introduction 

SoftPanel-2 is a system for creating and deploying GUI-based soft control 
panels on a network. The system consists of a Panel Creation Module that 

provides tools for designing the GUI panels; either as replicas of the 

UCP-series hardware panels, or as free-form panels designed from a palette 

of buttons, displays, and other control devices. 

After a panel is created, it is published to the network with specific access 

control rights that determine which users or groups of users can access the 
panel. The SoftPanel-2 Panel Creation Module receives the system 

programming information from the Utah Scientific U-CON System 

Configuration Utility. The router definitions, source, and destination tables are 

thus fully synchronized with the System Controller’s programming, ensuring 
that labelling in the SoftPanel-2’s panels matches the labels that appear on 

the hardware control panels. 

SoftPanel-2 comes with a full library of pre-drawn control panels that match 

the UCP-series panels in look and feel. This allows the operators who use a 
GUI-based panel to work with panels that they are familiar with. 

Panels created with the Panel Creation Module can also make use of 
GUI-specific features such as drop-down lists and check boxes. 

 

System Requirements 
• Windows 10, Windows 7, XP 

• Pentium 1.3 gigahertz (GHz) processor or faster 

• At least 1 gigabyte (GB) of RAM 

• At least 100 megabytes (MB) of available space on the hard disk 
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Configuration Overview 

The Utah Scientific configuration PC contains a folder called Ucon or Ucon-V4. The 
program in this folder communicates with the SC-4 / SC400 / SC40 system controller to 

configure sources and destinations for the video/audio routers.  

Note: SoftPanel 2 is compatible with Ucon v3.5.xx or newer. To verify the version of Ucon, 

click the “Help” item in the upper menu and select “About Ucon”. If the version is older than 

this, you will need to contact Utah Scientific customer service to learn how to upgrade the 

system controller and Ucon to the current required versions. 

The Softpanel 2 configuration software can reside on any desired network PC that has 

access to the Client PC’s, which in turn have access to the system controller IP address. 

The Client PC’s contains the Softpanel 2 “Player” application, which is used to switch the 
video/audio routers. The relationship between the system controller and the soft panels is 

simply a text file of sources and destinations that is exported from the Ucon Datastore 

software and then imported into the Softpanel 2 configurator.   

The soft panels are either used independently or in conjunction with hardware panels as 

shown in the illustration below. Hardware control panels can connect via Unet or Ethernet, 

whereas the soft panels are installed on a PC and run via Ethernet only.  

 

          

 

Ucon will send the exported information from the Datastore to the desired location on the 

network PC where the SoftPanel 2 configurator exists. The export function can be controlled 

manually or set to automatic. In the automatic mode, using U-CON, the operator sets the file 
to automatically export every time a change is made to the Source or Destination lists. 

The information is then manually imported into the SoftPanel 2 configuration. At this point, 

panels may be custom designed or created using default templates. The panels are then 

deployed to the desired client PC’s and then operated using the SoftPanel 2 Player utility. 
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Soft Panel Examples 
 
 

   Custom Design with Scrolling and Keypad 
 
 

    Custom Design with Locks and Destination Windows 

 

   Custom XY Design for QC 

 

  Template for 20x10 Matrix

New Version Update 
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Administrator 

It is recommended that the Softpanel 2 Configurator and Player 

applications are installed on a network PC and only the Player 
application is installed on the Client PC’s. The administrator for this 

software is simply the person whom is given access to the network PC 

where the Softpanel 2 application resides.  

The administrator is then given access to the SP2 configuration utility, 

which allows panel building and customization. The administrator also 

has access to the entire system panel inventory. The Configuration 

software uses the Ucon datastore export file to apply the desired sources 
and destinations where needed. Files are then saved in the panel folder 

where they are then deployed to the desired client PC’s.  

 
Basic System Operation 

Once the SoftPanel 2 program is installed on the Network PC, the file 

information can be exported from Ucon. This detail is then imported using 

the SoftPanel 2 configurator and a folder (alias name “controller”) is then 

created. This is where the export file will reside and where each new 
panel will be saved. Panels are then created and saved in this folder to 

be used directly from there or deployed to desired client PC’s. 

The SoftPanel 2 “Player” application can be installed and operated on 

additional client PCs on the same network as the SC4 / SC400 / SC40 
controller. Once this is complete, the panels will connect to the system 

controller via the IP address that resides in the panel configuration file, 

which originated from the Ucon export file. 
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2 
Softpanel 2 Configuration 

 
The soft panels use the device (index) numbers of the source and destination 

tables based in the SC4/SC400 controller config that the panels are 
connected to via Ethernet. The following procedure is to be used for properly 

configuring and connecting the soft panels to the SC4. 

NOTE: The SC4 must be running on software v1-7-1 (or newer) with 

UCON v3-5-1 (or newer). If this is not what your system is currently 

using, follow the steps found in Section 2 of the System Installation 

Guide (UTSCI System Updates and Upgrades). THE U-CON SOFTWARE 

VERSION IS LOCATED WITHIN THE PROGRAM’S HELP MENU/ABOUT. 

FOR ASSISTANCE LOCATING THE SC-4’S SOFTWARE VERSION, SEE 

‘Device Software Lookup’ in the System Installation Guide. 

 
SP2 installation 

1. Open windows explorer 

2. Locate the directory release-softpanel2 inside the install2020 folder. 

(SoftPanel 2, System Installation CD). 

3. Double-click the setup.bat file. This installs softpanel 2 on the local 

PC's hard drive (c:\usi\softpanel2) 
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UCON Export 

All Sources and Destinations located within the current U-CON Datastore 
must be introduced to the SoftPanel 2 configuration. These will be the same 

Sources and Destinations that were sent to the SC-4/SC-400 controller via 

U-CON. 

1. Start UCON, locate, then open the current datastore. 
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2. Select FILE->Set Export Src/Dest List Settings 
 

 

3. Select Browse and select a directory to export the list to (the default 

location is c:\ucondatastore\Export). 

 

 
Click OK when finished. 

UCON Export 
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4. Select FILE->Export Src/Dest List. This generates a file in the 
export directory. 

 

 
You will see the following dialog when the operation is complete. 

 

 
This completes the U-CON portion of this exercise. U-CON is not required 
for further SoftPanel 2 operation, and can be closed at this time. 
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Automatic Export 

The export file can be sent directly to the folder automatically. This would 
happen after changes to the data store occur and the ‘Save’ button is 

pressed. 

1. With the data store running, select FILE->Set Export Src/Dest 
List Settings. 

Automatic Export 
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2. Select Browse and select a directory to export the list to (the default location is 
c:\ucondatastore\Export). 

 
3. Change the ‘Export Events’ from manual to automatic by clicking the check box. 

Then click OK when finished. 
 

 
Note: Once automatic is set, it will not be possible to manually export the file 

from the menu. 
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Importing the U-CON Config File 

1. Double-click SoftPanel2Config.exe. This is located in the bin 

folder, which can be found in the recently created SoftPanel2 
directory (c:\usi) 

 

The following will appear: 

Importing the U-CON Config File 
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2. From the Tools menu, select Import Ucon File. 
 

 
3. Select BROWSE in the dialogue window. 

 

 
4. Change to the directory you exported the UCON data to and 

select the ucon export file. 
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5. In the Select a Controller to Update input box, type the name of 

the controller (ex KUSI), then click Update. This will create a new 

controller directory in softpanel2. (Example 
c:\usi\softpanel2\KUSI). 

 

Importing the U-CON Config File 
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This will complete the process. 
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3 
SP2 Panel Configuration 

 
Using the Toolbar and Panel Dropdown Menus 

When the configurator program first opens (as shown on page 2-7 step 1) the 

following toolbar and dropdown menu will appear in the top left of the 
program. 

 

 

 
Toolbar 

The only items that are functional when the configurator is first launched will 

be the first three icons. HINT 1: To view the name of any icon, roll the mouse 

over any icon (commonly called flyover) and wait a second. The name is also 

related to its function. A more detailed description of the button will be shown 
in the status bar at the bottom of the screen. HINT 2: Equivalent use of the 

icons are also located in the dropdown menu items called ‘File’ and ‘Edit’ and 

will be shown below. Each of these also have quick key functions and can be 
seen in the dropdown menus. 

‘New’ - this is the white icon that looks like a blank sheet of paper. This may 

be used to begin creating panel from scratch and will automatically open a 

blank canvas in the working area of the configurator. 
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‘Open’ - this is the next icon that looks like a slightly opened file folder. 
This may be used to open a panel from the working folder or from the 

templates folder. 

‘Save’ - this is the third icon that looks like a disc. This is used to save the 

current panel to the templates folder or to the working folder. NOTE: 

panels should always be saved in the working ‘Controller’ folder that is 
created from the import function shown in section 2 above. If they are 

saved in any other location, they will not work properly as this is where the 

import file from UCON is located and used from. 

The next four icons are used for editing panel items. They will appear 

grayed out and will be activated when a panel is opened as seen in the 

figure below. 

 

 
‘Cut’ – this is the icon that looks like scissors. When a single item or 

multiple items are selected on a panel, this will remove them from the 

canvas. 

‘Copy’ – this is the icon that looks like two identical pieces of paper. When 

a single item or multiple items are selected on a panel, this will copy all of 
these to the working clipboard to be used for pasting when ready. NOTE: 

Only one copy can be performed at a time. Each time ‘Copy’ is pressed it 

will overwrite the previous copy. 

‘Paste’ – this icon looks like a clipboard with a piece of paper on its lower 

right corner. When pressed, this will paste the items that were copied to 

the clipboard from the ‘Copy’ function. 

‘Toggle Lock’ – this is the icon that looks like a padlock. When this is 

pressed it will lock the drag function from the mouse, however all other 
functions may still be used. 
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Dropdown Menus 

When the configurator is first open, only the ‘File’, View’, ‘Tools’ and ‘Help’ 
items will appear. The remaining items, as seen in the figure below, will open 

into view when a panel is opened. 
 

 
‘File’ – some items in this dropdown menu are also accessible using quick 

keyboard keys as well as the icons in the tool bar. The ‘Close’ item will close 

the current panel that is open on the canvas and prompt to be saved if 
changes were made. The ‘Save As’ item will allow the current panel to be 

renamed or saved again if desired, by opening a ‘Save Panel’ window. 

Additionally, the lower section of the ‘File’ dropdown will allow the user to 
open a panel that was previously opened. The last panel that was opened will 

be number 1 in the list. Up to four previous panels will be listed from most 

recent as number 1 to the forth one away as number 4. 
 

 

‘Edit’ – all of these items in this dropdown menu are also accessible using 
quick keyboard keys as well as the icons in the toolbar. The only additional 

item is ‘Undo’ and is only accessible from this menu and the quick key ‘Ctrl Z’. 

This will undo as many changes that were made all the way back to the last 
save that was performed. 

Using the Toolbar and Panel Dropdown Menus 
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‘View’ – these views may be turned on or off from here. A check mark 

next to the item enables the view. The ‘Toolbar’ is the upper left icons for 
editing, opening and saving work. The ‘Status Bar’ is the information bar 

located at the bottom of the application. ‘Tips’ are occasional items that 

appear while working on the panel functions. 
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‘Shapes’ – all but the bottom three items in this menu are the alignment and 

grouping tools which can also be used from the icons just above the panel 

canvas. These functions are used with multiple buttons and displays only and 
will be grayed out until more than one button and display are highlighted 

together. These will be described in detail farther along in this chapter. 

The lower three items in this menu are used to set the default colors that will 
appear on the buttons and rectangle backgrounds that are added to the 

control panels. 
 

Using the Toolbar and Panel Dropdown Menus 
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‘Panel’ – there is only one item in this menu and it is titled ‘Tie-line’. When this is selected it 
will change the function table to the view seen in the figure below with additional items called 

‘Tie-Line’ and ‘Audio Channel’. This is only used with specific video cards and software with 

audio shuffling capability. To turn the function view back off so these items are no longer 
displayed in the function menu, click ‘Panel’ and ‘Tie-Line’ again and it will prompt for the 

change. 
 

 
 
 

‘Tools’ – This was described in section 2 above in detail. It is used to import the working 

datastore file from UCON in order to begin creating panels. 
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‘Window’ – there are no limit to the amount of panels that can be opened at 

the same time. This menu is used when more than one panel is opened. The 

panels will appear in a numbered list at the bottom and the panel that is 
currently being worked on will have a check mark next to it. 

 

Using the Toolbar and Panel Dropdown Menus 
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The ‘Arrange Icons’ and ‘Split View’ items are not operationally useful in this application. 
However, the other two are described below. 
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This is the ‘Cascade’ view and will layer the panels in a cascading format. 
 

 

 
This is the ‘Tile’ view and will display the panels in a flat view all at once. 

 
 

‘Help’ – This displays the version of Softpanel 2. 
 
 

Using the Toolbar and Panel Dropdown Menus 
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Initial Setup 

Initial panel creation involves the placement of button types from the 
menu tree within the development area. The Controls selection contains 

pre-defined templates for use in your SoftPanel 2 development. This is 

recommended as a means of faster panel implementation. 

If for any reason you would like to delete one of the panel’s buttons or 
button groups, simply highlight the unwanted portion and press the Delete 

key. A red outline will appear whenever a button or button group is 

highlighted. You can also move panel parts easily when the target areas 
are highlighted. Basic PC functions apply here; copy, paste, delete, etc. 

In this part of the exercise, you will create a ready-to-use panel from an 

existing template. This template, along with many other usable layouts 

are located in a pre-developed folder. These steps will familiarize you with 
the process. You can apply any one of the panels to your own operation, 

or create a new one by selecting New from the File menu. 

1. Double-click SoftPanel2Config.exe (if it is not already 
running.) This is located in the bin folder, which can be found 

in the recently created SoftPanel2 directory (c:\usi). This is 

the same procedure as step one above. 

2. Select FILE->Open, then open the TEMPLATES entry shown 

in the dialogue box. 
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3. Double-Click the MULTI-DEST entry under TEMPLATES1. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. ‘Template’ is used in this example, but is not required. 

Initial Setup 
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Your screen should appear as follows. (Note: For the best on-screen view and editing capabil- 
ity, click the configurator and panel’s maximize button. In this ‘maximized’ mode you can 

re-size each panel, which will then become the panel’s new size when opened later in the 

Player mode.) 
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4. Select FILE-SAVE AS, and save the multi-dest to the controller 

directory. 
 

Initial Setup 
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5. Add Sources/Destinations (Groups) using the lower-left hand window by selecting 
the Sources or Destinations tabs, then dragging them onto the buttons. 

 

2 1. Sources and Destination 
tab view 

2. Click + for expanded view 

3. Drag Source or Destination 

to button 

1 

3 
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You can use any button on the panel (above); or modify any one for your par- 

ticular use by using the Control and Function sections (tabs) in the lower left 

corner of the interface. 
 

 
• Assign a direct destination by dragging a destination from the 

“Destination Device” section of the screen and dropping it onto the direct 

destination buttons. After you have dragged one direct destination you 

can select the next three just by clicking on another “Destination Device” 

and it will be automatically assigned to the next button. 

• Assign a direct source by dragging a source from the “Source Devices” 

section of the screen and dropping it onto the direct source buttons. After 

you have dragged one direct source you can select the next direct 

source by clicking on another “Source Device”. It will then be 

automatically assigned to the next button. 

• To configure a group on a group button, left-click on any device in that 

group (from the “Source Devices” or “Destination Devices”) and drop it 

on the desired button. All of the sources or destinations in that group will 

be included in the panel, except the ones that are placed in the “Exclude” 

list. 

• The panel will use the first Direct Destination as the default destination 

(the one that it will use when the panel powers up). 

• To unassign a group name, direct destination, or source on a button, use 

the right mouse button and click the button that you want to unassign. 

Initial Setup 
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Controls/Buttons - Setup 

The buttons include 6 fixed sizes and types of which the sizes cannot be altered. 

 
Figure 3-1. 

 

The first button added to any new panel is placed by left-clicking, then dragging 
the button to the panel. 

Figure 3-2. Initial button placement 
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The default color for all buttons can be set prior to adding the buttons to the 

canvas. To do this, locate the three color selection boxes just above the 

working canvas area which look like the following figure. 
 

 
There are three options for colors. The first one is for the upper and lower half 

of the dual buttons. The second option is for single buttons. And the third 

option is called ‘Rectangle’ and is for setting a default color for the item in the 
‘Control’ list under buttons. This is for adding rectangle boxes to the canvas 

as background layers behind buttons or whatever else is desired. 

Controls/Buttons - Setup 
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Drop down the arrow next to each of these items to set the default colors. When 
the button is then added to the canvas, it will use the color that was set as the 

default. The following three figures show these color pallets after they have been 

selected. 
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Once it has been added to the screen, the color of any button can be changed 

to any desired color by simply right clicking on the button and selecting the 

item in the list called ‘Color’ as seen in the figure below. 
 

Controls/Buttons - Setup 
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From that point forward, buttons are added to the display area by simply 

double-clicking the button type from the buttons folder. The buttons folder allows 

you to select and place content within the display area only. 

Figure 3-3. Subsequent button placement 

 

There are three additional items in the ‘Control’ menu that can be added to the 

canvas and used as desired. They are ‘Displays’, ‘Rectangle’ boxes and ‘Text’ 
boxes. 

 
Displays 

Displays can be used for source or destination status depending on the function 
that is assigned to that display. Refer to the ‘Function’ description table in this 

guide for details on how to use these. There is no limit to how many displays may 

be used. 

 
Rectangle 

This is an option for adding a background layer anywhere on the panel. It is 
always furthest back in the layers so as to allow buttons, displays or text boxes to 

be placed on top of it. 

 
Note: It is only capable of being used with colors and cannot have 

any images loaded as the background. 
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To use this option, click, hold and drag the rectangle onto the canvas. Then 

click on any edge to adjust the box for the desired size. To move the box 

around, click, hold and drag it to the desired location. Use the arrow keys on 
the keyboard for smaller increments of movement. The following figure is an 

example of a background of black behind the keypad on a panel. 

Controls/Buttons - Setup 
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Text Boxes 

This is an optional box that can have text added to it. There are a variety 
of fonts and sizes to choose from. The text box however, is only 

transparent with no options of color, lines or backgrounds are available. 

To use this option, click, hold and drag the rectangle onto the canvas. 

Then click on any edge to adjust the box for the desired size. To move the 

box around, click, hold and drag it to the desired location. Use the arrow 
keys on the keyboard for smaller increments of movement. The following 

figure is an example of two text boxes. One is completed and the 2nd has 

the curser around it highlighted. 
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Customizing Buttons 

By right clicking on any button, display, text box or rectangle box, the following 
menu will appear. 

 
 

 
The menu items that are usable for each of these devices will be available 

and seen as not grayed out. A description of each of these menu items is 

listed below. 

‘Color’ – There are three options for this selection. One is for a dual style 
button. The second is for a single style button. And the third is for a rectangle, 

background selection all of which are shown below. These are all described 
Controls/Buttons - Setup section above. 

Customizing Buttons 
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‘Remove Encoding’ – This option is used only with buttons and blanks 

out the selection that has been dropped onto that button. This does not 
include the functions but only the source and destination that is on the 

button. Another option for this instead of removing the encoding is to drag 

another source or destination on that button type. 



Customizing Buttons 
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As seen in the figure below, only the ‘All’ item will appear in the menu. There 

is no ‘Top’ or ‘Bottom’ selection that is usable at this time. 
 

 
‘Change Font’ – Fonts may be changed on buttons, text boxes and displays 

but not on rectangle boxes. Normal font changes may be changed along with 

colors and text sizes. 
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‘Custom Text’ – This option may only be used on buttons and is used to change or add text 
to a button after it is created from the default source or destination list that is imported from 

UCON. After the source or destination appears on the original button when it is dragged onto 

the button, when this menu item is selected the following box will appear. It will allow a top, 
middle and bottom line of text to be added and will replace the original text. NOTE: Any 

number, letter or character may be used and there is no limit to how many of these there are. 

The button may also be stretched by grabbing any corner and making it larger as needed. 

(See figures below for detailed views). 
 

 

 



Customizing Buttons 
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‘Properties’ – This will bring up a window that will show information regarding 

that item. This includes the position and color of that device along with the 
encoding, text and custom text related to that device. 
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This is especially helpful for buttons and displays that are associated as it will show which type 
of association has been applied. (See figures below for detailed views). 

 

 
 

 



Alignment and Sizing 
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Alignment and Sizing 

The first four items control alignment activity; left, right, top, and bottom. Any 
buttons highlighted (in the display area) will be stacked in accordance with the 

selected operation. 

 

 
Figure 3-4. Alignment controls 

 

Specifically, all highlighted buttons will align with the first button selected in 

your display area -- either on the selected button’s left, right, above or below 

(top and bottom). Note that if the buttons are in a row and you align left or 

right, the buttons will stack on top of one another. 

Buttons are aligned by highlighting the target group, then clicking the desired 

alignment option under the Controls group area. Be cautious about left and 
right stacking order, as buttons or groups can pile on top of one another, 

obscuring buttons underneath. There are multiple levels of undo (CNTRL-Z) 

in the event a wrong selection is made. 

 
Sizing, Cloning Buttons, and Displays 

The next three items in the tool bar (figure above) are for cloning multiple 
buttons and displays to be the same as a chosen button and display. 

To use this option, first click on the button or display that you would like the 

others to resemble. Next, hold the ‘Ctrl’ button down on the keyboard and 

click the button or display that you would like to make the same as the chosen 

one. This will turn on the next three selection tools in the tool bar. 
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Click on either of the first two controls in order to clone the desired buttons or displays width or 
height the same as the chosen one. Click the third cloning tool button to snap the desired 

buttons or displays to the exact size as the chosen one. NOTE: The first button or display that 

is selected is the one that the other selected items will be cloned to. 

Buttons and displays may be sized to different heights and widths by clicking and holding the 

mouse over any edge of the item and then dragging it to the desired size as seen in the figure 
below. Then cloning the item is much easier in making them the exact same size. 
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Grouping Buttons and Displays 

The last two items in the tool bar are for grouping and ungrouping (associating 
and disassociating) button and displays together. 

 
 

 
NOTE: This function may only be used with the function titled 
‘Associated Destinations’ and is used with a single display and a 

single button. It is used to associate the two together with spe- 

cific functions related to a destination assigned to that button. 
To properly use these buttons you must first click the desired 

button and then hold the ‘Ctrl’ button down on the keyboard and 

click the display that is to be used with that button. With both 

highlighted, click the ‘Group’ button (left button) in the toolbar 
above. Next, from the function table selected at the bottom left of 

the screen, go to ‘Functions’ and drop down the function item 

called ‘Associated Destinations’. Choose the desired item from 
the list and drag it onto the destination button. There are four 

selections: 

Grouping Buttons and Displays 
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1. ‘Preset’ also requires a ‘Take’ button to be added to the panel. When a destination is 

selected and then a source is pressed from the panel, the source will blink in the display 

prior to switching to that output. The user would then press the ‘Take’ button to activate 

the switch. 
 

 
2. ‘Direct’ – when this mode is applied to a destination button, it will immediately update 

any source that is pressed. It is directly taken to that destination without a prompt. 

 

 
3. ‘Status’ is used to show status of sources that are routed to that destination in the display 

from any panel that makes switches. This function only needs to be dropped onto a 

destination display, which is not associated to a destination button. After it is dropped 

onto a display, go to the destination list at the bottom left of the screen and drag the 

desired destination onto the status display. NOTE: this is a status display only and will 

now show the source that is connected to that destination with every switch that is made 
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and does not require any destination button on the panel as it will status 

when any panel on the network switches that destination. Ideally, a 

panel can be created with nothing but status displays to show only 

destinations and the sources that are applied to them. 
 

 

4. ‘Assignable’ allows the user to right click the button and select from a 

table of all the destinations on the controller and switch it up as a preset 

or take option to that destination. Then when a source is selected to go 

to that destination it will either blink if in preset mode or take it directly 

when in ‘Take’ mode. 

 

Grouping Buttons and Displays 
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Destination Displays 

The Destination Displays, located within the Control group area, act as a 
means for providing status for another button’s assignment. Though 

button status will be revealed in the destination display box, these status 

displays are not officially associated with another button until the user 

makes the connection. To associate the destination display with another 
button, you must first assign a Function to the destination display box. In 

this case, ‘destination display’. Next highlight both items (button and 

Destination Display box), and click ‘Associate’, located in the Control 
Operations group area. An association can be verified by first highlighting 

the destination display box, then clicking its associated button 

counterpart. The button’s [destination] will appear inside the destination 

display box when the association is valid. Finally, click Save-As from the 
File menu. 

There are two types of Destinations; the regular Destination that reveals 

only the current destination, and an ‘Associated Destination’ that contains 

the [destination] status inside the Destination Display box. 
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Functions 
 

 
• The function menu has items that can be added to the various buttons and 

displays depending on how they are to be used. 

Functions 
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Sources 
 

 
This is the Sources function. This function will assign the button to the 

Source Group. When this button is pressed a direct take will occur. 
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Destinations 
 

 
The Destination group will assign a button to control a given destination for 

this panel. The brightly lit destination is the current one that this panel will be 

switching to. If this panel does not contain any destination buttons, there 
should be a default destination assigned and labeled somewhere. In this way, 

the users can determine the appropriate output for this panel’s control. 

Functions 
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Levels 
 

This type of level function is designed for simplicity and ease of use. If you 

assign a button as a “Level 1” through “Level 8” button, it functions in the 

following manner: 

If the button is lit, this level will be used when the Direct Source button is 

pressed. If you want to eliminate a level from being taken with the next 
Direct Source button, press the button to extinguish it. In the same 

manner, press it again to illuminate it and this level will be included when 

the Direct Source buttons are pressed. 
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There is no indication as to which level is being statused on the Direct Source buttons. The 

level being statused is the last level button that was illuminated. For example, to see the status 

for “Level 1”, press the “Level 1” button to turn it off, then press it again to turn it back on. This 
will set the panel to show the status on “Level 1”. 

 
Split Level Button 

 

 
The split level buttons were designed to be used on the UCP-2, UCP-36, and UCP-72 panels. 

They give the user the ability to control 8 levels on 4 buttons. They should be used in 

conjunction with the “Panel Mode Buttons” and “Level Shift 1-4/5-8” button. This gives the user 

the ability to shift between levels 1-4 and 5-8. 

Functions 
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The bright level is the level being statused. The backlit levels are valid for 
the current destination, while the levels that are off are not valid for this 

destination. 

To setup a breakaway take, press the brightly lit button and it will start 

blinking. Select other levels in this same manner. 



SoftPanel 2 3-41Sof 

 

 

 

 

 
 

Split Level Button 1-16 
 

 
The split level buttons were designed to be used on the UCP-XY, UCP-SX, and the UCP-MX. 

They give the user the ability to control 16 levels on 8 buttons, and should be used in 
conjunction with the “Panel Mode Buttons” and “Level Shift 1-8/9-16” button. This gives the 

user the ability to shift between levels 1-8 and 9-16. 

If one of these levels are bright, it indicates that this level is valid for the currently selected 
destination. 

Functions 
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Direct Salvo 
 

A Direct Salvo can be assigned to a button. To accomplish this, drag a “Direct Salvo #” and 

drop it on a button. When this button is pressed, it will send a command to the controller that 
will execute the direct salvo. The salvo must be configured in the SC4 first before this button 

will execute anything. 



SoftPanel 2 3-43Sof 

 

 

 

 

 
 

Dual Direct Destination 
 
 

This allows a button to select the actual destination the panel will control. 

Assign (2) destinations to the button after assigning this function to the button. 
Once that happens, this button can be used to select the destination this 

panel will control. 

Functions 

S
e
c
ti

o
n

 
3
 



SP2 Panel Configuration 

3-44 Panel Configuration 

 

 

 

Dual Direct Source 
 

 
This allows the button to select between two different direct sources on 

one button. Use this button function in conjunction with the Panel Mode 
Buttons/Source Shift function. In conjunction with the ‘Source Shift”, the 

user can have two different sources on one button. This will double the 

number of direct sources this panel can control. 
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Protect/Lock 
 
 

 
1. Clear Only 

This function clears a “Protect” or “Lock” that has been set on the current 

output. This type of button function should be used in conjunction with the 

Protect Only and the Lock Only functions. The user can set a “Protect” or 
“Lock” and then use this button to clear them. 

2. Protect Only 

This assigns the function of “Protect” to a button, allowing the button to set a 
protect on the current output. A protect will allow this panel to continue to 

make takes but will not allow any other panels to make takes on the current 

output. 

Functions 
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3. Lock Only 

This assigns the function of “Lock” to a button. This allows the button to 
set a lock on the current output. A Lock secures the output so that no 

panels can make takes on this output until the Lock is cleared. 

4. Protect/Clear Toggle 

This is a toggle button that allows the user to set a “Protect” on the current 
output. You can then press the same button to “Clear” the protect. A 

“Protect” will lock the output so that only the current panel can make takes 

on this output. (To clear the “Protect” press the button again.) 

5. Lock/Clear Toggle 

This is a toggle button that allows the user to set a “Lock” on the current 

output. You can then press the same button to “Clear” the protect. A 
“Lock” will lock the output so that no panels can make takes on this 

output. (Press the “Lock” button again to clear the lock.) 

6. Protect/Lock/Clear Toggle 

This is a toggle button that allows the user to press the button three times 
to cycle between a Protect-Lock-Clear. Press the button first to set a 

“Protect” on the current output. Press the button again to clear the 

“Protect” and set a “Lock”. Press the button a third time to clear the 

“Lock”. 

• A “Protect” locks all other panels from making takes on the 

current output while allowing the current panel to continue to 

make takes. 

• A “Lock” locks all panels from making takes on the current 

output. 

• A “Clear” clears a “Lock” or “Protect” that have been set on 
the output. 
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Panel Mode Buttons 

 
1. Clear Button 

This button is used to cancel any pending operation such as a pending take. 
Pressing the clear button will return the panel back to a normal operating 

mode. 

2. Level Shift 1-8/9-16 

This button is used to shift the levels for the 8 source displays. This button is 
also used in combination with other buttons to view and set parameters on the 

panel. Check the UCP panel manual for more information about the function 

of this button. 

Functions 
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3. Select Dest 

The Destination Select button is used to select a different destination on 
the panel. This button will allow you to enter and new group name and 

extension destination for this panel to control. 

4. Scroll UP 

This button is used to scroll up through the sources or destination on 
panels that have display windows. You can press the scroll button until 

you find the desired source then press the TAKE button. Check the UCP 

manual on how to switch the panel from scrolling between Destination 
and Sources. 

5. Scroll Down 

This button is used to scroll down through the sources or destinations on 

panels that have displays windows. You can press the scroll button until 
you find the desired source then press the TAKE button. Check the UCP 

manual on how to switch the panel from scrolling between Destination 

and Sources. 

6. Attribute Mode 

This button allows panels that have displays to setup or breakaway audio 

attributes on the router. Pressing this button puts the panel in to 

“attribute” mode. It will stay blinking until it is pressed again. Refer to the 

UCP panel manual on how to use the Attribute mode in the panel. 

7. Salvo Button 

This button allows you to send a salvo buffer number take to the 

controller. Pressing this button the word “SALVO 0” is placed into the 

destination display. You can then enter a 3 digit number and then press 
TAKE. The panel will send that buffer number to the controller. If that 

salvo is configured on the controller it will execute it. Refer to setting up 

Salvo’s in Chapter 2 of this manual. 

8. Protect/Lock Mode 

This button will place the panel into Protect/Lock Mode. It should be used 
on a panel that has displays. The Protect button will continue to flash until 

it is pressed again. While the panel is in protect mode you can setup 

Protects or Locks on different levels as well as different destinations. 

When the panel in not in Protect Mode this button will status Bright RED if 

the current destination has a protect or lock enabled on it. 
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9. Level Shift 1-4/5-8 

This button is used on panels that only have 4 level buttons. It should be 

used in conjunction with the “Split Level Button” group defined in this chapter. 

It allows you to the ability to select 8 levels on the 4 level buttons by splitting 
the buttons in half. 

10. Source Shift 

This function should be used in conjunction with the “Dual Direct Source” 

function defined in this chapter. It allows the “Direct Source” buttons to control 

two sources instead of just one. The “Source Shift” button controls which half 
of the “Direct Source” button will be used when it is pressed. 

 
Take Button 

 

This will assign the take functionality to a button. After configuring a take, this 
button should be pressed to send the take to the controller. 

Functions 
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Keypad Buttons 
 

 
The Keypad layout buttons are mainly used on the UCP-2 panel. They 

define the keypad layout of 0 - 9, A - F, and 16 - 19. 
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Source Displays 

Source Displays 1 - 8 are individual functions within any larger display that 
was previously dragged to the work area. All Source Displays work in unison 

with Levels 1 - 8 (located above, Button Functions list). 
 

Figure 3-5. Source Display selection 

 

Source Displays work in conjunction with the Levels selections (also 1 - 8). 
When the panel is running, the program will display the sources that are 

switched to the specified destination on the associated Level. 

Functions 
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Single Source Displays 

The following will occur when a Single Source Display (function) is 
dragged to a button: 

Figure 3-6. Single Source Display 

 

Any time any source button is pressed, regardless of the destination, the 

program will display only that particular source in the window, each time. 

The same result will occur no matter which Destination is current -- the 

program will display the same Source in the window. 
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Destination Displays 

Mode 1 - As with the Source Display, any time the Destination Display is 
dragged in as a function, the program will always display that particular 

destination in the window, and nothing else, not matter the Destination 

pressed. Any source assigned will not appear in the display. This is a 

destination display only. 

Mode 2 - An associated Destination Display (associated with a specific 

destination button). The program will status the source that is currently 
switched to, on that specific destination only. 

Figure 3-7. Destination Display 

 

The Destination Displays, located within the Control group area, act as a 

means for providing status for another button’s assignment. Though button 

status will be revealed in the destination display box, these status displays are 

not officially associated with another button until the user makes the 
connection. To associate the destination display with another button, you 

must first assign a Function to the destination display box. In this case, 

‘destination display’. Next highlight both items (button and Destination Display 
box), and click ‘Associate’, located in the Control Operations group area. An 

association can be verified by first highlighting the destination display box, 

then clicking its associated button counterpart. The button’s [destination] will 
appear inside the destination display box when the association is valid. 

Finally, click Save-As from the File menu. 

There are two types of Destinations; the regular Destination that reveals only 

the current destination, and an ‘Associated Destination’ that contains the 
[destination] status inside the Destination Display box. 

Functions 
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Snapshot 
 

 
Snapshot buttons are used for defining a set of takes which can be 

triggered by pressing this button in the actual soft panel or retrieving a 
snapshot from the menu and taking it from there. These are only used 

with multiple destinations such as a monitor wall and are not to be 

confused with salvos. One or more of the outputs can be taken at the 
same time using a snapshot by retrieving the snapshot as a preset and 

then performing a take with the desired outputs by choice. 
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Previous 
 

There are two options in the Previous folder. Both relate to reverting back to 
the previous switch after a take is made. This does not undo the current take 

but it literally goes back to the previous take made. The option called ‘Preset 

Previous’ shows the previous take in a blinking state before taking it, allowing 

the user the option to cancel or continue on with a Take. This mode also 
requires a Take button on the panel. The option called ‘Previous’ will perform 

the take without a prompt. 

Functions 
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Associated Destinations 
 

Refer to the section above titled, ‘Grouping Buttons and Displays’ for 

details on using these associated buttons. 
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Assignable Destinations 
 

 
With this assigned as a destination button, the user can right click on the button in the panel to 

open the entire destination list of which they can select the desired destination. 
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SP2 Panel Operation 
1. Double-click SoftPanel2Config.exe (if it is not already running.) 

This is located in the bin folder, which can be found in the recently 

created SoftPanel2 directory (c:\usi). 
 

 

The following screen will appear: 
 



SoftPanel 2 3-59Sof 

 

 

 

 

 
 

2. Select File->Open Panel, click your controller’s folder (created above) 

and select the MULTI-DEST item. Click OK. 
 

The following screen will appear: 
 

 

The cell in the upper-left corner should be green, indicating a successful con- 

nection to the controller. Red indicates a bad network connection between the 

SoftPanel’s PC and the SC-4. 

SP2 Panel Operation 
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3. Select 1 of the destinations 

4. and then select sources to make takes. 

First click (Dest) 

Second click (Source) 

Result - Status 
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Functions Requiring Additional Details 
 

Levels and Level Shift Buttons 

Levels are physical video and audio routers that are defined in the controller 

source and destination tables. The sources and destinations are assigned 
names, as well as physical BNC connection numbers within these levels. Levels 

are identified by the controller by dip switch assignments that are unique to each 

level, generally beginning with level 1. If your system has multiple video and 

audio routers (levels), then in most cases switches will be performed as ‘All Level 
Takes’ where all video and audio routers switch together. However, you will have 

the ability to break these levels away and perform switches only to specific levels 

as desired. That is when you would create individual level buttons that are 
assigned to these router levels. There are several ways of using these functions 

of which are described in the following steps. NOTE: Refer to section 3 above for 

details on creating these buttons. 

 
‘Individual Levels’ 

There are two views below showing a panel created with some simple direct 

sources and destinations along with 8 single level buttons. These buttons have a 
display that is added from the function list item called ‘Source Displays’. These 

displays are listed from 1 through 8 and represent those levels. These source 

displays, as well as the destination display, are not required but will show the 
source that is connected to the destination that appears in the destination display. 

The first view is from the configurator as to how it appears when the buttons and 

displays are created. The other view is from the actual panel when it is on line. 

Functions Requiring Additional Details 
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To use the breakaway function, press all of the desired level buttons that 
are NOT wanted when the switch is made. This will disable those levels. 

Do not press the levels that are part of the breakaway switch. Next, press 

the desired source button and it will switch only that source to the desired 
breakaway levels. 
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‘Split Levels 1-8’ 

There are two views below showing a panel created with some simple direct sources and 
destinations along with 4 split level buttons. These buttons have levels 1-4 on the top half and 

levels 5-8 on the bottom half and requires the use of the level shift button called ‘Shift 1-4 and 

Shift 5-8’. There is also a display above each level button that is added from the function list 

item called ‘Source Displays’. These displays are listed from 1 through 8 and represent those 
levels. These source displays as well as the destination display are not required but will show 

the source that is connected to the destination that appears in the destination display. When 

the levels are toggled to the lower half, the displays will status correctly for levels 5-8. 

The first view is from the configurator as to how it appears when the buttons and displays are 

created. The other view is from the actual panel when it is on line. 

To use the breakaway function, this works the opposite of single level breakaways. Press all 

of the desired level buttons that ARE to be switched in the breakaway. This will enable those 

levels. Do not press the levels that are NOT part of the breakaway switch. Next, press the 

desired source button and it will switch only that source to the desired breakaway levels. If a 
breakaway is desired on levels 5-8, first press the ‘Shift 1-4 and Shift 5-8’ button to toggle to 

the lower half of the level buttons. 

 
USE PIC 26B HERE 
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‘Split Levels 1-16’ 

There are two views below showing a panel created with some simple 

direct sources and destinations along with 8 split level buttons. These 

buttons have levels 1-8 on the top half and levels 9-16 on the bottom half 

and requires the use of the level shift button called ‘Shift 1-8 and Shift 

9-16 ’. There is also a display above each level button that is added from 

the function list item called ‘Source Displays’. These displays are listed 
from 1 through 8 and represent those levels. These source displays as 

well as the destination display are not required but will show the source 

that is connected to the destination that appears in the destination display. 

When the levels are toggled to the lower half, the displays will status 
correctly for levels 9-16. 

The first view is from the configurator as to how it appears when the 

buttons and displays are created. The other view is from the actual panel 

when it is on line. 
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To use the breakaway function, it works the opposite of single level breakaways. Press all of 

the desired level buttons that ARE to be switched in the breakaway. This will enable those 
levels. Do not press the levels that are NOT part of the breakaway switch. Next, press the 

desired source button and it will switch only that source to the desired breakaway levels. If a 

breakaway is desired on levels 5-8, first press the ‘Shift 1-4 and Shift 5-8’ button to toggle to 

the lower half of the level buttons. 
 

 
 

 

S
e
c
ti

o
n

 
3
 



SP2 Panel Configuration 

3-66 Panel Configuration 

 

 

 

Using Salvo Buttons 

Salvos are single button ‘Takes’ where a series of events of source and 
destination combinations switch. These must be created and stored in the 

SC4/400 using the UCON software application. These salvos will send 

the request to the SC4/400 to switch using the numbers in the Softpanel, 

which directly correspond to the salvo number in the SC4/400. NOTE: 
There are two ways of configuring salvos in the Softpanel. The first way is 

to create them as ‘Direct Salvos’, which has a limit of eleven only. The 

second way is to create a ‘Salvo’ button as a group, which will then allow 
the user to select from the entire list of 128 possible salvos that can be 

created in the SC4/400. This second way also requires keypad numbers 

to be on the panel in order to select the number of the salvo. Both of these 

methods are described below in detail. NOTE: Refer to the UCONV4 
manual, section 2, for details on setting up the salvos in the SC4/400. 

 
‘Direct Salvos’ 

To use a direct salvo, simply press the desired salvo button 0-9. These 
correlate specifically to the salvo 0-10 in the SC4/400. The switch will 

happen immediately and the last output and its input will appear in the 

destination and source displays, if there are level displays created on the 

panel. NOTE: the displays are not required. Also, if desired, custom 
names can be put on the salvo buttons to describe that salvo. 
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‘Selecting Salvos from Keypad’ 

If there are more than eleven salvos that need to be switched from a Softpanel, then the panel 

must have keypad numbers 0-9, depending on what numbers are needed, and a take button. 

A salvo can be ran from any destination that is currently showing in the destination display as 

the salvo has nothing to do with this. To select the desired salvo, first click the salvo button. 
The word Salvo will appear if in the destination display (if there is a display on the panel). 
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Next, press the desired salvo number from the keypad. This number 
related directly to the number of the salvo created in the SC4/400. Press 

the Take button and the salvo will switch. 
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Assigning Destinations and Sources 

There are two options for assigning destinations when creating these from the configurator. 

One is from the ‘Associated Destinations’ and the other is from the ‘Assignable Destinations’ 

menu items. 

To assign a destination from either option, right click on the destination button and the 

following window will appear. 
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The associated option will have a display that shows the source status of 

what is switched to the assigned destination. The assignable option does 

not require a display. With either option there is also a source select that 
will bring up the source list of which the user may select from the entire 

list. NOTE: click the ‘Take’ item in the window to send that source directly 

to the destination. Otherwise, if ‘Preset’ is selected, then a Take button is 

required on the panel. 
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Using Snapshots 

Snapshots can be created, saved and used from the menu in the actual 
soft panel. They can also be saved to a button that was put onto the 

Softpanel from the configurator program. If a button is used then it can be 

set in the panel as either a preset or actual take when the button is 

pressed. 

 
Saving a Snapshot 

To save a snapshot first open the desired soft panel and the click on the 
menu item at the top of the soft panel called “Snapshots” and choose 

“Save Snapshot” as seen below. 
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When the save snapshot window appears, type the desired name for that snapshot, along 

with a description if desired. The name will be used to retrieve or edit the snapshot and the 
description if for notes only when that snapshot is viewed. Click OK to save. 
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Retrieving a Snapshot 

To retrieve a snapshot, click on the menu item at the top of the soft panel 
called “Snapshots” and choose “Retrieve Snapshot” as seen below. 

 

 

When the window opens, choose the snapshot from the left of the screen 
and then at the bottom of the screen choose either “Preset” or “Take” to 

execute the snapshot, or “Cancel” to abort. 
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If “Preset” is selected, all of the outputs will blink with the source in their 

displays that were saved in the snapshot. If any of the outputs are not to be 

switched, these can be cleared by right clicking on that output and selecting 
the “Clear” function. These will stop blinking and not change when the take 

button is clicked. 
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Editing a Snapshot 

To edit a snapshot, click on the menu item at the top of the soft panel 
called “Snapshots” and choose “Edit Snapshot” as seen below. 

 

 
With the edit window open you may change the name or description of 

that and then save it by clicking OK, or you also have the option of 

deleting that snapshot. In any of these cases there will not be a prompt to 
delete or overwrite any changes, so be certain of what you want to do. If 

no changes are to be made, either click OK or Cancel to exit prior to any 

changes. 
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Using a Snapshot from a Button 

While in the soft panel, right click on the button called “Snapshot”. Select “Assign 
Snapshot” and the following window will appear. 

 

 
With the selection window open, choose the desired snapshot from the upper left 

window. Type in the desired names as wanted, in the left section for the top, 

middle and lower titles and check the box next to each of them. 
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Click the desired action as “Preset” or “Take” in the lower left which will 
either come up blinking as a preset, waiting for the take button to be 

pressed, or as a direct take which will happen immediately upon pressing 

the snapshot button. 
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SoftPanel 2 Workstation Distribution 
1. Place the entire Softpanel 2 folder (found on c:\usi in desired location) 

on the network where the workstations and the SC4 have access. The 

UCON program should also be run from this location. 

2. Build the panels using the Softpanel config program and save them to 

the controller folder previously created in the Softpanel 2 installation 

process. 

3. Create shortcuts of the newly created panels on the Softpanel remote 

workstations. The file will have a .pnl extension. 

4. Associate the soft panel shortcut to the Softpanel.exe on the network 
server. 

5. If the remote workstations are on a different network than the SC4, a 

gateway may be needed as well as changing the subnet mask. In this 
case refer to Appendix D of this guide. 

6. When changes are made to the src/dst tables in the SC4 via UCON, 

they will automatically be sent to the export file that was created in the 
Softpanel 2 installation process. You will then import that file using the 

Softpanel 2 configurator that will then update all of the panels that 

were previously created as needed. 

Usage Example – Adding 1 or more Panel Displays with Multiple Functions 

(Note: Certain references to ‘Source’ below may actually refer to ‘Destination’) 

SoftPanel 2 Workstation Distribution 
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Without association, the Source Display box acts as a status display with 
no associative connection to anything else. The display will status every 

source that is pressed without any regard to destination. The destination 

display will simply update the Source within the window whenever a desti- 
nation is clicked. 

The Source displays (1 – 8 in the Function tab area) represent specific 

Levels. When, as an example, one of the ‘level dedicated’ Source Dis- 
plays is assigned to Level 2, the display will only status Level 2. 

Again, a single source display will only provide status for the last Source 

button pressed, not matter what the output. 

The Four Operational Modes – Related to Association 

§ There is a Source Display for Source Status 

§ Source Levels for Level Status 

§ Destinations – to provide status as a destination 

§ Associating the Display to a Separate Destination 
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